# Contents

Introduciton........................................................................... vii

Chapter One: Setting Up the Software......................... 1
  System Requirements.................................................. 1
  Installing Family Tree Maker................................... 3
    Using the Automated Setup Installer...................... 3
    Manually Installing Family Tree Maker................. 5
  Getting Help in Family Tree Maker........................ 6
    Using the Help Program...................................... 6
    Navigating in the Help Program......................... 9
  Tutorials............................................................. 10
  Getting Started Guide........................................ 10
  Technical Support.............................................. 12

Chapter Two: Tutorial: Building a Tree......................... 13
  Before You Begin.................................................. 14
  Creating a Tree.................................................... 14
  Part 1: Entering Information About a Family.............. 16
    Entering Basic Information in the People Workspace.. 17
Contents

Adding Parents and Grandparents ...................... 26
Removing an Individual from Your Tree ............... 34

Part 2: Adding More Details ................................. 36
Entering a Fact ............................................. 37
Adding a Source for a Fact ............................... 39
Adding a Note ............................................. 43
Creating a To-Do Task ................................. 45
Viewing a Timeline ........................................ 47
Viewing Relationships ................................. 49

Part 3: Adding Media Items .................................. 49
Adding a Media Item to a Tree ......................... 50
Entering Details for a Media Item ...................... 53
Linking a Media Item to an Individual ................. 55

Part 4: Putting Your Family on the Map .................... 56
Viewing Diana’s Birthplace .............................. 57

Part 5: Searching for Information Online .................. 60
Using Web Search ......................................... 60
Merging Online Information into a Tree .............. 63

Part 6: Printing a Family Tree Chart ....................... 65
Displaying Edward Spencer’s Descendant Tree ...... 67
Displaying Diana Spencer’s Ancestor Tree .......... 69
Printing a Tree Chart ..................................... 75

Part 7: Finishing Up ........................................... 76
Backing Up Your Family Tree Maker Files .......... 76
Closing Family Tree Maker ............................ 78

Thank You ....................................................... 79
Chapter Three: Troubleshooting ...............................81
Before You Begin .............................................. 81
  Checking System Requirements ......................... 81
  Windows Basics ........................................... 82
Installation Problems........................................... 84
Program Unexpectedly Shuts Down ....................... 88
Printing Problems............................................. 88
PDF Problems.................................................. 92
CD-ROM Problems........................................... 92

Index............................................................................93
Congratulations on selecting Family Tree Maker to discover and preserve your family’s heritage. It's quick and easy to use for those just starting to research their family history, but it’s also robust enough for the most serious genealogist. Use Family Tree Maker to store, display, and print any kind of family information you want—from names, birth dates, marriages, and deaths to priceless family stories, pictures, and audio/video files.

We want your first experiences to be satisfying and enjoyable, so please take some time to read this Getting Started Guide. It will help you install Family Tree Maker and take you step-by-step through an informative tutorial showing you just how easy it is to record your family heritage.

- **Build Your Family Tree**—Enter facts in the People workspace by filling out the labeled fields, beginning with what you know.
• **Enhance Your Family History**—Add family photos, images of records, or scans of family heirlooms to your tree. And you only need to add each media item to your tree once; then you can easily link each item to as many people in your tree as you’d like.

• **Create Charts and Reports**—Enter names and other information just once, and Family Tree Maker uses the information to create as many trees and reports as you wish. Let your creativity soar by adding pictures and customizing the formatting to create heirloom-quality trees that you can share with others.

• **Search for Ancestors**—Verify dates, locations, and other facts you’ve entered and search for new information online. The powerful Web Search feature will point you to data on websites such as Ancestry.com. Locate a family member and then use the Web Merge to add your findings directly into your family tree.
This chapter shows you how to install the Family Tree Maker software on your computer and gives you a quick introduction on getting help as you’re working in Family Tree Maker.

System Requirements
The computer equipment you will need is shown on the next page. Keep in mind that the more family information you enter, the greater the amount of free hard drive space and available RAM you will need. If you plan to include many images or videos in your trees, you will need a substantial amount of hard drive space.

If your system does not meet these minimum requirements, we cannot guarantee that the program will function correctly. You will need to upgrade your system to meet these requirements if you want to use this version of Family Tree Maker.
Recommended System Requirements

Microsoft Windows® XP SP2/Vista™
1GHz Intel Pentium® III (or equivalent)
460MB for installation/512MB RAM
1024x768 resolution monitor
32X CD/CD-R (Some supplemental products require a DVD-ROM drive.)

All online features require Internet access. User is responsible for Internet Service Provider (ISP) account, all Internet access fees, and phone charges.

Minimum System Requirements

Microsoft Windows® XP SP2/Vista™
500MHz Intel Pentium® II (or equivalent)
460MB for installation/256MB RAM
800x600 resolution monitor
2X CD-ROM (required for installation)

Note: System configuration may require minor adjustments to the configurations of your operating system and/or updates to the hardware component drivers. As with all Windows programs, a faster processor, more RAM, and more free disk space will enhance performance.
Installing Family Tree Maker

To use Family Tree Maker, it must be installed on your computer’s hard drive. You cannot run it directly from the original CD-ROM. If you already have a version of Family Tree Maker installed on your hard drive, it will remain on your computer. The new one will not copy over the old one. While this installation process will not harm your existing Family Tree Maker files, it is always a good idea to keep a backup of your files in a different location such as on a flash drive, CD, or DVD.

Family Tree Maker utilizes an automated installation system—built into the CD-ROM—making setup fast and easy.

Using the Automated Setup Installer

To install Family Tree Maker using the automated Setup Installer, insert the Family Tree Maker Installation Program CD into your CD-ROM drive. When the launcher appears click the Begin Installation button and follow the directions on these windows:

- **Welcome**—The Setup Installer begins running automatically, displaying a series of screens welcoming you to the program and asking you to read and approve the license agreement.
License Agreement

Please read the license agreement. You can view it during the software installation or at a later time by locating the license.txt file in the same folder where you installed Family Tree Maker.

- **Choosing Destination Location**—The normal destination directory for Family Tree Maker is a folder called Family Tree Maker 2010 located in the Program Files folder on your hard drive. In most instances, this will be your “C” drive.

- **Setup Status**—You will see messages and status bars as the appropriate files are installed on your hard drive.

- **Internet Connectivity Options**—If you have Internet access, you can take advantage of the Family Tree Maker Web Search capability and receive automatic notification of updates to the program. If you don’t wish to take advantage of these features or if you are not connected often, you may deselect these options. You can also change these settings in the software in **Options**, under the **Tools** menu.

- **Customer Registration**—We offer registered users of Family Tree Maker the following special benefits: the powerful Family Tree Maker Web Search feature and the ability to merge Ancestry.com records into your tree; access to dynamic maps; discounts on future
Family Tree Maker

versions of Family Tree Maker; and notifications of updates.

• **Setup Complete**—After completing the installation process, click **Finish**.

**Manually Installing Family Tree Maker**

If, for some reason, Family Tree Maker does not automatically launch the Setup Installer, please follow the instructions below:

**Note:** Family Tree Maker automatically suggests the best choices, so if you come to an option and are unsure about what to do, select OK.

1. Click the Windows **Start** button and then select **Run**. Windows displays the Run window.
2. In the **Open** field, type “D:SETUP”.

**Electronic Customer Registration**

If you choose *not* to register during the installation of Family Tree Maker, you can still access the convenient electronic registration form:

From the **Help** menu in the software, select **Register Family Tree Maker**. Follow the instructions on the screen.
Note: The “D” in “D:SETUP” stands for drive D. If you are installing from a CD-ROM drive other than drive D, type that letter instead. For example, to install from drive E, type “E:SETUP”.

3. Click OK.

4. Now you can return to “Using the Automated Setup Installer” on page 3 in this chapter and follow the steps to complete the installation.

**Getting Help in Family Tree Maker**

Family Tree Maker has a convenient, built-in Help program. At any time, you can access Help for the current window you are viewing or editing. You can also search the Help program by typing in a topic or phrase, then viewing and/or printing the resulting explanation.

**Using the Help Program**

1. Do one of these options:
   - From the Help menu, select Help for Family Tree Maker.
   - Press the F1 key (located at the top of your keyboard); then click the Show button.
Family Tree Maker displays the four-tabbed Help window (see figure 1-1):

- **Contents tab**—displays a list of Help topics arranged logically in chapters, like the table of contents of a book. Each chapter is identified by a book icon. You can double-click a book to see the contents of each chapter. For chapters with sub-chapters, double-click on the subsequent book icons (sub-chapters) until you funnel down to individual Help topics. Read individual Help topics by clicking on the topic you are interested
in. The topic will be marked with a question mark in a square and will appear in the left panel of the dialog box.

- **Index tab**—works like the index in a book. Find the term you’re interested in and double-click it to see the corresponding Help topic.

- **Search tab**—lets you search for words or phrases that may be contained in a Help topic.

- **Glossary tab**—displays a list of useful terms you might encounter in Family Tree Maker.

2. Click the **Search** tab and do one of the following:

   - **Type the first few letters of the word you’re looking for**—This field is where you enter the word, phrase, or topic you want to know more about. Many useful topic pages can be found by entering the keywords “adding,” “creating,” “displaying,” “entering,” “individual(s),” “information,” and other action words.

   - **Use the scroll bar to select the index entry you want**—Once the keyword or phrase you’re looking for is highlighted, click **Display**.

The Help page opens. If there is more than one choice for your entry, Family Tree Maker may display a second window. Simply make your selection and click **Display** again.
Navigating in the Help Program

The built-in Help program makes extensive use of “links” to take you to other related topic pages. These links are easily identified by their blue, underlined text. Simply click on any link to go to a new topic page. Once there, you can click **Back** to return to the previous page or click the Index tab to return to the Index.

The Help information pages have their own menu items at the top of each page. Use these options to move around within the Help program:

- **Hide/Show**—Click to return to the tab view of the Help window or vice versa.

- **Back**—Click to move back through the series of Help pages you have navigated using the blue, underlined text links. When you get back to your original Help page, this option will be grayed out and unavailable.

- **Forward**—After using the Back button, click to move forward through the help items from which you backtracked.

- **Print**—Click to print the currently selected Help page. A print dialog box will be displayed from which you can select any available options, then print the page to keep for future reference.
• **Options**—Click to display a sub-menu of additional options, such as “Search Highlight On,” which you can use to turn off and on an automatic highlight feature that helps you search for words.

**Tutorials**

Family Tree Maker includes a variety of tutorials that illustrate and explain how to use Family Tree Maker. With these tutorials—available directly from your software—you will quickly learn how to organize, research, and share your family history.

1. From the **Help** menu in the software, select **Training Tutorials**. The tutorial window opens. On the left side of the window, you’ll see a list of topics you can choose from; each one correlates to a workspace in the software.

2. Click a topic to launch the tutorial.

**Getting Started Guide**

This *Getting Started Guide* can also be viewed as a PDF on your computer. If you chose to include the guide when you installed Family Tree Maker 2010, follow the steps below to find and read the guide. If you didn’t install the guide on your computer, you can find it on the CD-ROM.
1. Double-click the **My Computer** icon on the desktop.

2. Double-click the icon labeled **C:** (the default location for installing programs).

3. Double-click the **Program Files** folder.

4. Double-click the **Family Tree Maker 2010** folder (or the folder you chose to install the software in, if different).

5. Double-click the **Manuals** folder.

6. Double-click the **Getting Started Guide** (Guide.pdf). If you are not able to view the PDF version of the manual, you will need to install Acrobat Reader, which is available for free download from the Adobe website <www.adobe.com>.

---

**Activating Your Ancestry.com Subscription**

If you are already a member of Ancestry.com or if a free membership came with your Family Tree Maker purchase, you can activate your subscription within the software. Once you’ve activated your account, you can use the Web Search feature to merge Ancestry.com records into your tree.

From the **Help** menu in the software, select **Activate Ancestry Subscription**. Follow the instructions on the screen.
Technical Support

Family Tree Maker includes an Online Help Center that is a resource for answers to technical problems or customer service questions. You’ll find easy-to-understand articles, tips, step-by-step instructions, and tools for using Family Tree Maker. To access the Help Center, select Online Help Center from the Help menu or go to <www.familytreemaker.com/support>.

If you prefer, you can write to: The Generations Network, 360 West 4800 North, Provo, Utah 84604. Please be aware that the minimum response time for written communication is four to six weeks.
Chapter Two

Tutorial: Building a Tree

This tutorial shows you how easy it is to use Family Tree Maker by leading you step-by-step through the main features of the program. We will be using the family of Diana Spencer, Princess of Wales, as an illustration. The Spencers are one of Britain’s aristocratic dynasties. Their family roots branch across many countries, including Great Britain, Germany, and even the United States. Diana Spencer can trace her lineage back to King Charles and shares a common ancestry with internationally known figures such as Sir Winston Spencer Churchill and President George W. Bush.

As you begin the tutorial, you will enter information about Diana’s family, including her parents and grandparents. Then you’ll add a photo, notes, and a source to the tree. Also, you’ll use the powerful online search tool in Family Tree Maker to search for information on the Web; then you will print a custom ancestor tree—one type of tree you can create with the software.
This should take about an hour, but don’t feel that you have to do it all at once. When you’re finished with the tutorial, you should feel confident about using the most useful commands and options in Family Tree Maker.

Before You Begin
This chapter assumes that you know how to use a keyboard and mouse, have read Chapter 1, and have installed Family Tree Maker on your computer. If you haven’t done these things, go back and follow the instructions in Chapter 1. After you complete the items listed above, you’re ready to begin this tutorial.

Creating a Tree

1. Turn on your computer.

2. Do one of these options:
   - Double-click the Family Tree Maker icon on the desktop.
   - Click the Windows Start button. From the Start menu, select All Programs, then Family Tree Maker 2010. From the sub-menu, select Family Tree Maker 2010 again.

If this is your first time using Family Tree Maker 2010, you will now see the New Tree tab on the Plan
workspace (figure 2-1). If you have already entered information, Family Tree Maker will display your current tree.

3. On the New Tree tab, click **Enter what you know**.

4. Since you’re going to enter information about Diana Spencer’s family in this tutorial, type “Diana Frances Spencer” in the **Name** field.
5. Choose “Female” from the drop-down list.

6. Enter “SPENCER” in the New tree name field.

   Note: To change the drive or folder where your tree is saved, click File Location and choose a new location. You cannot save the tree to a floppy disk or CD—your tree must be on your hard drive while you’re working on it. But, you can keep a backup of your tree on a removable drive or CD.

7. Click Continue.

   The program opens to the People workspace, where you will continue the tutorial, entering information and facts about Diana and her family.

**Part 1: Entering Information About a Family**

In this section you’ll enter information about several generations of the Spencer family. Follow all the steps exactly and soon you will be printing your first tree chart in Family Tree Maker.

   The People workspace is where you enter information about the individuals in your family. The Family tab is made up of an index of individuals in the file, a pedigree
tree that helps you navigate to different generations of a family, a family group view of a couple and their children, and an editing panel where you can enter basic information (figure 2-2).

![Figure 2-2. Family tab on the People workspace](image)

**Entering Basic Information in the People Workspace**

On the Family tab in the People workspace, you’ll enter some facts about Diana Spencer’s immediate family, starting with Diana Spencer herself.
Figure 2-3 shows what the People workspace will look like when you’ve entered Diana’s family. The steps that follow tell you how to enter the information like it is shown in the figure.

Because you already entered Diana’s name when you created your new tree, you’ll notice that her name is highlighted in the pedigree tree and is the focus of the editing panel.

Note: In this tutorial, any information that you should type is shown in quotation marks (“ ”).
1. In the editing panel (figure 2-4), click the **Birth Date** field and type “Jul 1 1961”.

   ![Editing panel]

   *Figure 2-4. Editing panel*

   **Note:** You may want to press the Tab key to move to the next field.

2. Next, click the **Birth Place** field. Notice that when you leave the Birth Date field, Family Tree Maker
automatically converts the abbreviated date you entered to the genealogical standard date format (01 Jul 1961).

Note: Normally, Family Tree Maker can figure out dates no matter how you enter them. If Family Tree Maker cannot understand the date you enter, it will ask you for clarification. Simply retype the date in a more standard format (as shown in this step).

3. Type the name of Diana’s birthplace, “Sandringham, Norfolk, England”, in the Birth Place field.

4. Fill out the next two fields with the following information: “August 31, 1997” for the death date (notice
how the date automatically changes to the genealogical standard format) and “Paris, France” for the death place.

5. To add Diana’s husband, click Add Spouse in the pedigree tree or the family group view. In the field that appears, enter “Living Windsor” and click OK. This new individual becomes the focus of the workspace.

Note: To protect the privacy of individuals who are still alive, we will enter “Living” instead of the individual’s name.

6. Fill in this additional information for Diana’s husband (refer to figure 2-4 if you need help).

**Birth:** “November 14, 1948” in “London, England”.

7. Diana and her husband were wed on “July 29, 1981”, so enter that in the Marr Date field.

8. Click the Marr Place field and type “London, England”. Because you previously entered London, England, as a location, its name appears in a drop-down list. You can continue typing the location or choose it from the list.

You’re now finished entering basic information about Diana Spencer and her marriage, so you can move on to her children.
In the family group view (see figure 2-5), click Add Child. In the field that appears, enter “Living Windsor” and click OK. This child becomes the focus of the workspace.

Notice that Family Tree Maker automatically fills in the last name “Windsor” for you. This is Fastfields at work.

In the editing panel, choose a gender for the child; select “Male” from the drop-down list. Then press Enter or click OK to go on to the Birth Date field.

Type “6/21/1982” in the Birth Date field and press Enter.
Family Tree Maker converts the date you type into a standard date format. Family Tree Maker may ask you to clarify the date (in this case 1982) if it does not recognize the format you’ve used. Make sure the final date says “1982”.

**Fastfields**

Fastfields is a special feature that allows you to save time by not having to enter the same information over and over again. Perhaps you noticed that as you began to type the name “Windsor,” Family Tree Maker automatically filled it in for you. This is because name and location fields, among others, are Fastfields.

Location Fastfields remembers the names of any location you’ve entered into a tree. This means that when you move the cursor into a location field and start typing the name of a town that you’ve previously entered into Family Tree Maker, Fastfields automatically tries to fill it in for you. In addition, Family Tree Maker also contains a database of more than 3 million place names, and as you type in a location, Family Tree Maker will suggest possible matches. Type the name of the town until Family Tree Maker suggests the right location; then use the keyboard arrows to highlight the location and press Enter to select it. You can also keep typing a name to override the Fastfields suggestion.

13. Type the following information in the appropriate fields for Diana’s other son:

   Name: “Living”
   Sex: “M”
   Birth date: “Sep 15, 1984”

   We have deliberately left out some information, so there are blank fields. You can either leave the fields blank or type “Unknown”. If you have an approximate date, you can also indicate this by typing “About 1920,” which Family Tree
Maker abbreviates to “abt.1920”. Once you have entered more names than can fit on the window, a scroll bar appears on the right side of the “Children” section—use this to view additional children. Also, you can see the total number of children entered for the parents by looking for the number to the right of the “Children” heading in the family group view.

Congratulations! You’ve just finished entering a basic family. To make sure all of the information is correct, compare your People workspace to figure 2-6 on the previous page.

If you spot a typographical error, go back and change it. Just click the field containing information you need to change and use the left and right arrow keys to move around within the field.

**Correcting Mistakes**

If you make a mistake when entering information, you can use the Backspace key to delete the incorrect characters. You can also fix mistakes by simply typing over them with the correct information. To do so, click in the field where you see a mistake. Click the left button on your mouse and drag the cursor until all the text you want to change is highlighted. Then click the Delete button on the keyboard or simply type in the new information.
Adding Parents and Grandparents

In addition to letting you enter information about a family, the People workspace also has a pedigree tree that helps you navigate to multiple generations of a family—grandparents, parents, their children, and so on. As you work on your own family trees, you will use the pedigree tree often, moving back and forth through the generations.

For the purposes of this tutorial, you’ll go only backwards in time and fill out the information for Diana Spencer’s parents and grandparents. You would go forward in time to fill out information for her children, grandchildren, great-grandchildren, and so on. In your personal trees you’ll do both.

Now, you’ll enter information for Diana’s parents.

Adding Diana’s Parents

1. Make Diana the focus of the workspace again by clicking her name in the pedigree tree—her name in the tree will become highlighted.

2. Click Add Father above and to the right of her name (see figure 2-7 on the following page).
3. Enter the following for Diana’s father, Edward Spencer:

   Name: “Edward John Spencer”
   Birth: “Jan 24 1924” in “England”

4. Click Add Mother in the pedigree tree and enter the following information for Diana’s mother, Frances Burke Roche, and her marriage:

   Name: “Frances Ruth Burke Roche”
   Birth: “Jan 20, 1936” in “Sandringham, Norfolk, England”
   Marriage: “01 June 1954”
You don’t have information for the location of Edward and Frances’s wedding, so you can either leave the field blank, enter “Unknown”, or enter a question mark “?”. For now, just leave it blank.

For this tutorial, you don’t need to enter any more information about their children, though you should understand how to from entering Diana’s children previously. Check what you’ve typed against figure 2-8.

**Adding Additional Spouses**

Diana’s father, Edward, married again after he and Frances Burke Roche (Diana’s mother) divorced. In this section, you’ll learn how to add information if either the husband or
wife has been married more than once. In the family group view, next to Edward Spencer’s name, there is an icon of a person. This “Spouse” icon lets you add information about another wife or husband.

1. Click the Spouse icon next to Edward Spencer’s name.
   
   From the drop-down list, you have the choice of accessing the information for an existing spouse or creating information for a new spouse. You can add as many spouses as needed.

2. Choose Add Spouse from the drop-down list. The Add Spouse window opens.

3. Type the name of Edward Spencer’s second wife, “Raine McCorquodale”, in the blank field and click OK.
   
   Family Tree Maker displays a new family group view—this time with Edward Spencer in the “Husband” section and Raine McCorquodale in the “Wife” section.

4. To return to the family group view with Diana’s mother, click the Spouse icon again and this time choose “Frances Ruth Burke Roche.”
   
   Family Tree Maker returns you to Edward and Frances’s family group view.
Choosing a “Preferred” Spouse

Because Frances was the first wife entered for Edward in the tree, she is considered the “preferred” spouse of Edward. (Usually this is the spouse whose children are in your direct line.) This tells Family Tree Maker that you want Frances to be shown when you display Edward’s family, not Raine.

If you wanted Raine to be the spouse who automatically displayed on Edward’s family group view, you would follow these steps to make her the “preferred” spouse:

1. Make sure Edward Spencer is the person of focus, or highlighted individual, in the People workspace.
2. Click the Person tab.
3. Click the Relationships button.
4. In the Spouses list, click Raine’s name.
5. In the editing panel, click the Preferred spouse checkbox.

You now need to go back one more generation to fill out two more family group views—one for Diana Spencer’s paternal grandparents (the parents of her father, Edward) and one for her maternal grandparents (the parents of her mother, Frances).

Note: Don’t skip the next section of the tutorial. You won’t have to enter a lot of information, and you will need this information to create charts in Part 6 of the tutorial.
Adding Diana’s Paternal Grandparents

1. Edward Spencer and Frances Burke Roche should be shown as husband and wife of the family group view. Click Edward’s name in the pedigree tree to make him the focus of the workspace. In the pedigree tree, click Add Father above Edward (not Frances).

Family Tree Maker displays the field where you will enter his father’s name (figure 2-9).

![Figure 2-9. Edward Spencer in the pedigree tree](image)
2. Using the techniques taught in the previous tasks, enter the following information about Diana’s grandparents:

Diana’s paternal grandfather was named Albert Edward John Spencer. Her paternal grandmother was Cynthia Eleanor Beatrix Hamilton.

Adding Diana’s Maternal Grandparents
In this section, you’ll fill in information about Diana’s maternal grandparents, but first, you’ll need to make her mother, Frances Burke Roche, the focus of the family tree. This is because Frances is the closest relative whom you have already entered. In such a small tree, the easiest way to access Frances’s information would be to click her name in the pedigree tree. However, at some point, your tree will contain hundreds and perhaps thousands of names. This task teaches you a quick way to move between individuals in your tree—regardless of the number of people your tree contains.

To access Frances’s information:

1. In the index of individuals on the left side of the window, start entering “Roche” in the Find field (see figure 2-10 on the following page).
As you type, you’ll notice that Frances’s name becomes highlighted. She also becomes the root individual in the pedigree tree.

Now you’re ready to fill in information about Diana’s maternal grandparents. The only information you’ll enter is the name of her maternal grandfather—Edmund Maurice Burke Roche.
To enter Diana’s maternal grandparents:

1. In the pedigree tree, click the **Add Father** button for Frances.

2. Enter “Edmund Maurice Burke Roche” in the blank field and click **OK**.

   That’s all you need to enter for Frances’s parents. Now you are ready to make Diana Spencer the focus of the workspace again. This time you’ll use a different feature. Because Diana is the home person, or primary individual, of the tree, her information can be easily accessed with the click of a button.

To display Diana’s information:

1. Click the **Go to home person** button located at the top of the index of individuals (figure 2-11). Diana becomes the focus of the workspace.

![Index: 10](image)

*Figure 2-11. Go to home person button*

**Removing an Individual from Your Tree**

It’s always good practice to check your information from time to time. Sometimes you’ll find that you have mistakenly added an individual that isn’t related to you. Don’t worry—Family Tree Maker makes it easy to delete an individual from your tree.
1. In the main menu bar at the top of the Family Tree Maker window, click the **Person** menu and select **Delete Person**.

   Family Tree Maker asks you to confirm that you want to delete Diana’s information. For this exercise, you will not actually delete her from the file.

2. Click **No**. (If you clicked **Yes**, Diana’s information would be deleted from your family tree.)

   Family Tree Maker returns you to the People workspace.

   **Note:** Remember to use the **Delete Person** menu option whenever you want to remove someone permanently from your file. If you try to delete an individual by simply removing his or her name from the Name field, you won’t actually delete the individual—or any of his or her facts or relationships. And if you delete a name and replace it with another, Family Tree Maker will mistakenly attach all the facts to the new individual, assuming that you have merely changed the name’s spelling.

In all the tasks you’ve performed so far, you have been entering general family relationships. We’ll now learn how to enter more specific information for an individual.
Part 2: Adding More Details

So far, you’ve only entered information in the People workspace on the Family tab. You might have noticed that the People workspace contains another tab, the Person tab. You can use this tab to enter, edit, and delete additional facts about an individual, including adoption, immigration, education, military service, nationality, retirement, and so on.

You should still be viewing Diana Spencer as the home person in the family tree. (If you’re not, click Diana’s name in the index of individuals.) Now click the Person tab. You should be viewing Diana’s Person tab (figure 2-12).

![Figure 2-12. Person tab for Diana](image-url)
**Entering a Fact**

We’ll now add a bit of information about Diana Spencer, Princess of Wales—specifically, that she worked as a kindergarten assistant in her youth.

1. Make sure you have accessed the Person tab for Diana.
2. If necessary, click the **Facts** button at the top of the window.

The information you’ve already entered for Diana appears in the Individual and Shared Facts section (figure 2-13).

3. Right-click the workspace and select **Add Fact**. The Add Fact window opens.
4. Find “Occupation” in the list and click **OK**.
In this case, an appropriate fact exists for the information we want to enter. If the fact we wanted to use was not found in the list (for example, college graduation), we could simply add it by clicking the **New** button in the Add Fact window. Family Tree Maker would then add it to the list of facts for future use.

Notice that the Occupation fact is added to the list, and the editing panel on the right-hand side has fields you can complete for the Occupation fact.

5. **In the Description field**, enter “Kindergarten assistant”.

Since we don’t have a specific date or location for this fact, you can leave the Date and Place fields blank. The description is added to the Individual and Shared Facts section.

For each fact you enter, you’ll want to record the “source” of the information. A source is any material where you find information related to the fact or event, such as a book, database, or person. Sources help you prove that the facts you’ve entered in your tree are accurate and also help others retrace or verify your information. For now, we’ll enter a basic source citation for the occupation fact you just created.
**Adding a Source for a Fact**

1. In the Individual and Shared Facts section, click the **Occupation** fact.

   In the editing panel, you should see “Occupation” and the description “Kindergarten assistant.” Beneath this you’ll see a small Sources tab. This is where you will add a source citation for the Occupation fact (figure 2-14).

![Figure 2-14. Sources tab](image)
2. Click the **New** button. The Add Source Citation window opens (figure 2-15).

![Add Source Citation window](image)

*Figure 2-15. Add Source-Citation window*

3. Click the **Source title** field and type “Diana: Her True Story”—the book where the information was found.

   Normally you would include additional information for the source, including author, publishing details, and more. In this exercise we will enter only the title.

4. Click **OK**. Because this is a brand new source, you’ll be asked whether you want to create a new source; click **OK**.

   **Note:** You can view all your sources by clicking the Sources button on the main toolbar.
**Creating Sources**

Family Tree Maker lets you enter sources in two ways: using a basic source format or source templates.

In this tutorial you’ll create a source using the basic format by simply entering facts about the source in standard fields (such as author, title, and publisher).

When you’re creating sources for your own tree, you may want to try out source templates; Family Tree Maker includes more than 170 templates based on the QuickCheck models used in Elizabeth Shown Mills’s book *Evidence Explained*—the premier reference for citing genealogy sources. Source templates ensure that your sources are consistent and are useful because you don’t have to guess which details need to be entered; choose the type of source you’re creating (for example, for an obituary) and Family Tree Maker displays the relevant fields.

Follow these instructions to use a source template:

1. Click the **New** button on the Add Source Citation window (see figure 2-15). The Add Source window opens.

2. Enter keywords in the **Source template** field or click the **More** button to view a list of all the available categories and templates. The fields that appear on the source citation window will change depending on the template you choose.

3. Complete the fields and click **OK**.
Now that you’ve entered a fact and its source, you’re ready to learn how to access some of the additional features available on the Person tab. Beneath the Individual and Shared Facts section, you’ll notice three tabs: Notes, Media, and Tasks. You won’t enter information in all of these tabs now, but here’s a short description of each one:

- The **Tasks** tab lists research tasks you’ve created for this individual, such as “Find birth certificate.”

- The **Media** tab lets you add pictures, videos, audio clips, and scanned documents to an individual. Working with these items will be explained in detail in *Part 3: Adding Media Items*.

- The **Notes** tab lets you record several pages of notes about an individual. This could be a useful place to copy a large chunk of information from another source (e.g., a story about the individual). Family Tree Maker even lets you spell check your notes.

This next section shows you how easy it is to enter notes by teaching you to enter some biographical information about Diana Spencer.
Adding a Note

1. Click the **Notes** tab at the bottom of the Person tab (figure 2-16).

![Figure 2-16. Diana’s Notes tab](image)

2. Place your cursor in the notes area.

3. Type “An important part of Diana’s life”.

   If you make a mistake, use the left arrow key to move the cursor back to the left and use the Backspace key to delete the incorrect characters.
4. Continue typing on the same line: “was her charity work.”

If you have a difficult time seeing the note, you can increase the display size by dragging the slider in the top, right-hand corner of the Notes tab.

5. Press the space bar once to start a new sentence. Do not press Enter or you will move the cursor to the next line. If you do, press the Backspace key to move the cursor to the end of the sentence.

6. Type “She dedicated her time to six specific organizations.”

As you can see, if a word doesn’t fit at the end of a line, Family Tree Maker automatically moves it to the beginning of the next line. You should press Enter only when you reach the end of a paragraph.

7. Press Enter to end the paragraph. Then press Enter once more to create a blank line.

8. Type the second paragraph: “The six charities were: Centrepoint for the homeless; the Leprosy Mission; the National AIDS Trust; the children’s hospital Great Ormond 46 Street; the Royal Marsden Hospital for cancer; and the English National Ballet.”
Your note should look similar to the one shown in figure 2-17.

Figure 2-17. Notes tab

Note: You’ll notice that there’s no save button on the Notes tab; Family Tree Maker automatically saves your notes as you enter them.

We’ll now use one of the other tabs at the bottom of the Person tab to enter a research task.

Creating a To-Do Task

The Tasks tab lets you keep track of the research tasks you still need to complete for an individual. Tasks can be as simple as phoning a relative with questions or as complicated as locating a missing birth or marriage certificate.
1. Click the **Tasks** tab at the bottom of the Person tab.

2. Click the **New** button. The Add Task window opens.

3. In the **Description** field, enter “Find an original copy of Diana’s birth certificate” (figure 2-18).

   ![Add Task window](image)

   *Figure 2-18. Add Task window*

If you were entering a task for an individual in your own tree, you could assign the task to a category (e.g., Spencers or Birth Records). You could also assign a due date or priority to the item.

4. Click **OK**.
You can view a list of every research task you’ve created in your tree. To do this, click the Plan button on the main toolbar; then, click the Current Tree tab. The Tasks section shows all the to-do items you’ve created in your tree. In this case, it shows only the one to-do item you have entered for Diana (figure 2-19).

Figure 2-19. Tasks To-Do List

Let’s continue on with the next task, where you’ll view a timeline of the events in Diana Spencer’s life.

**Viewing a Timeline**

Timelines can be a great tool to put the life of your ancestor in context—historical and otherwise.

You will need to access Diana Spencer’s Person tab. To do this, click the People button on the main toolbar; then click the Person tab.
1. Click the **Timeline** button. The events you’ve already entered for Diana appear in the timeline (figure 2-20).

![Timeline Table]

*Figure 2-20. Diana Spencer’s timeline*

2. To display Diana’s life along with historical events, click the drop-down list next to the Timeline button and select **Show Historical Events**.

3. To return to a timeline of Diana’s life, click the same arrow and deselect **Show Historical Events**.

   **Note:** You can also view a timeline of family events, such as other family births and deaths, by selecting Show Family Events.

   While you’re still on the Person tab, let’s take a quick look at the relationship table. This table is an easy way to see all the members of a family at a glance—spouses, children, parents, and siblings.
Viewing Relationships

1. Click the **Relationships** button.

The display changes to show all of Diana’s immediate family that have been entered in the tree (figure 2-21).

<table>
<thead>
<tr>
<th>Father</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Name: Edward John Spencer</td>
<td></td>
</tr>
<tr>
<td>Birth: 24 Jan 1961</td>
<td></td>
</tr>
<tr>
<td>Death: 25 Mar 1992</td>
<td></td>
</tr>
<tr>
<td>Relation: Father - Natural</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mother</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Name: Frances Ruth Burke Roche</td>
<td></td>
</tr>
<tr>
<td>Birth: 20 Jan 1936</td>
<td></td>
</tr>
<tr>
<td>Relation: Mother - Natural</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Spouse</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Name: Charles Spencer</td>
<td></td>
</tr>
<tr>
<td>Birth: 14 Nov 1948</td>
<td></td>
</tr>
<tr>
<td>Relation: Spouse - Ongoing</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Children</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Name: Prince William</td>
<td></td>
</tr>
<tr>
<td>Birth: 21 Jun 1982</td>
<td></td>
</tr>
<tr>
<td>Relation: Son - Natural</td>
<td></td>
</tr>
</tbody>
</table>

| Name: Prince Harry            |  |
| Birth: 15 Sep 1984             |  |
| Relation: Son - Natural       |  |

*Figure 2-21. Diana Spencer’s relationship workspace*

---

Part 3: Adding Media Items

The Media workspace in your tree acts as a storage space where you can keep all your multimedia items. You can store any type of electronic information, such as photos or scanned records, sound clips, or video clips. By adding media items to your history, you can create a wonderful collection of memories about each of your family members.
In this section you’ll learn how to add a picture to your tree. You’ll also find out how to link media items to people or sources.

**Adding a Media Item to a Tree**

There are several different ways to place media items into your tree, but for this exercise you’ll begin by opening the Media workspace.

1. Click the **Media** button in the main toolbar.

2. Click the **Add media** button in the right corner of the main toolbar and choose **Add New Media** from the drop-down list (figure 2-22).

![Add media button]

*Figure 2-22. Add media button*

Family Tree Maker displays the Select Media Item window. Because we are practicing, you can use any image file you have on your computer.

3. From the **Look in** drop-down list, choose a location where you have picture files.

Below the Look in drop-down list, Family Tree Maker displays a list of all the files and folders in the selected location.
4. Click the graphic file you want to use. An image of the item will appear in the Preview section (figure 2-23).

![Select media Item](image)

*Figure 2-23. Select media item window*

5. Click **Open**. The Copy to Media Folder window opens.

6. Do one of these options:
   - If you want to make an additional copy of this file and have it placed in a Family Tree Maker media folder, click **Copy this file**. (This is useful if you want to keep all your heritage photos in one location.)
   - If you don’t want to create a new copy of the file, and you want to link to the file in its current location, click **Link to this file**.
**Media Categories**

You can create as many categories as you’d like. Categories are useful when it’s time to print or search for a media item. For example, if you wanted to look at all of the items related to birthdays and you had given all of the family birthday photos the category “Birthday,” you’d easily be able to locate the birthday picture you need.

7. If you want, you can assign a category to the media item by clicking a checkbox in the Categories list.

The image now appears in your Media workspace (figure 2-24).

![Figure 2-24. The media workspace](image)
Entering Details for a Media Item

After you add an item to the Media workspace, it’s a good idea to enter details about the item: captions, dates, and descriptions.

1. In the Media workspace, select the item by clicking it once. For example, in the Media workspace for the Spencer tree, click on the picture you just added.

You can now enter information for the item in the editing panel (figure 2-25).

Figure 2-25. Media editing panel
2. Click the **Caption** field and type “Diana Frances Spencer”.

   This caption now appears in the Media workspace beneath the image.

3. Click the **Date** field and enter a date for the photo. (Normally this would be the date of origin for the item.)

4. Click the **Edit** button next to the **Categories** field.

5. Click the **Photos** checkbox to choose “photos” as the category this media item fits in; then click **OK**.

6. Click the **Description** field and type “Portrait of Diana Frances Spencer on her wedding day”. You can use this field to describe your media items more thoroughly than you can in the Caption field.

   Now that you’ve added a media item to your tree, you can link the item to the appropriate individual(s) or source(s). For example, if you have a wedding photo of your grandparents, you’ll want to link the picture to both your grandma and your grandpa. Or, if you have a scan of a census record, you’ll want to link the item to each member of the family who appears on the record and link the record image to a source.
Linking a Media Item to an Individual

If you have an item that relates to multiple people in your tree, you don’t need to add the item for each individual; simply add it once to the Media workspace and then link it to every necessary individual or source.

1. In the Media workspace, double-click the image you just added to the tree, or click the item and then click the Detail tab.

   At the bottom of the Detail tab, you’ll see a Links tab.

2. On the Links tab, click the New button and choose Link to Person. (If you were linking the item to a source, you’d click Link to Source-Citation.)

   The Add Media Link window opens (figure 2-26).

![Figure 2-26. Add Media Link window](image-url)
3. In the Name column, click the name of the individual you want to link the item to.

4. Do one of these options:
   - To link the item to the person, click Link to person only. (You can link to only one person at a time.)
   - To link the item to a specific fact (such as birth or marriage), click Link to person’s fact. Then click the fact in the list below.

5. Click OK.

Part 4: Putting Your Family on the Map
As you’ve entered the names and dates of Diana’s family, you’ve also entered a few locations where these events have taken place. Family Tree Maker keeps track of all the locations you’ve entered in a tree and automatically checks each place name for misspellings and missing data, such as missing counties. That way, you can keep your tree accurate and ensure that locations are recorded the same way every time they’re entered. In addition, Family Tree Maker includes new technology that lets you virtually visit each location in your tree.

Note: You must have an Internet connection to complete the next task.
Viewing Diana’s Birthplace

To show you how the online mapping works, we’ll now visit Diana’s birthplace and learn how to use a few of the map tools available in Family Tree Maker.

1. Click the **Places** button on the main toolbar.

2. In the Places list, you’ll see all the locations you’ve entered for the tree. Click **Sandringham, Norfolk, England**. You’ll notice that a road map of the selected location appears in the display area, the specified location centered on the map and marked with a pushpin (figure 2-27).

![Figure 2-27. A road map view of Sandringham, England](image-url)
In the upper, left-hand corner of the map, you’ll see map tools you can use to change the current view. Let’s try out a few options.

3. Click the plus sign (+) button to zoom in on the map; click the minus sign (-) button to zoom out of the map.

4. To view a combination of the road view and the aerial view, click Aerial in the map tools (figure 2-28). By default, location names (or labels) are shown.

*Figure 2-28. Aerial view*
Microsoft® Virtual Earth™

Family Tree Maker has partnered with Microsoft to let you access some exciting technology right from your Family Tree Maker tree. You can view road maps and special satellite and aerial images of locations around the world. Not only can you learn where your ancestors were born and spent their lives, you can visit and experience these places from the comfort of your own home.

Note: This feature is subject to change without notice.

5. To view a satellite image of the location without location names, click **Labels** in the map tools (figure 2-29).
Part 5: Searching for Information Online

Family Tree Maker makes it easy to search online for information about your family. Powerful search tools and Internet links to genealogy-related websites help you locate facts and add them to your tree— with the click of the mouse you can grow your family tree.

In this section, we’ll search for information on Diana Spencer in the databases at Ancestry.com. Then we’ll merge that information into the tree.

Note: You must have an Internet connection to complete these tasks.

Using Web Search

Diana Spencer should still be the primary individual, or focus, of the workspace. If not, go to the People workspace and click her name in the pedigree tree or index.

Searching Ancestry.com

Web Search can look through thousands of databases on Ancestry.com—including census records; birth, marriage, and death records; court and land records; immigration records; military records; family and local histories; and more. Depending on which Family Tree Maker package you purchased, you may already have access to a free trial of the data in one or more of these collections.
1. Click the **Web Search** button on the main toolbar.

2. In the Search Locations list, Ancestry.com is selected by default. In the browser you’ll see the Ancestry.com search fields completed with Diana’s name and birth and death information (figure 2-30).

![Figure 2-30. Web Search of Ancestry.com](image)
3. Click the **Search** button. You can click specific category links to narrow your search to different types of records, or scroll through the results to find a match (see figure 2-31).

![Search results on Ancestry.com](image)

**Figure 2-31. Search results on Ancestry.com**

4. Click on a search result. (In the tutorial it doesn’t matter which record you choose; however, when searching for your family, you’ll want to use search results that match the individual in your tree.)
After you click a search result, the bottom of the window displays the information in your tree compared side-by-side with the information you found online (see the Facts tab in figure 2-31 on the previous page).

**Merging Online Information into a Tree**

Once you identify a relevant Web Search result, you can merge the information directly into your tree. The Web Merge wizard makes incorporating the new data a snap. It will even include the source information for you automatically, and you can choose the pieces of information you wish to incorporate and whether that information should become the “preferred” or “alternate” information.

1. Make sure the result you want to merge into your tree is highlighted. The online information you found about that individual will appear in the Search result detail box at the bottom of the window (figure 2-32).

---

**Figure 2-32. Search result detail box**

<table>
<thead>
<tr>
<th>Person from your tree</th>
<th>Search result detail</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Diana F. Spencer</td>
</tr>
<tr>
<td><strong>Birth</strong></td>
<td>1961 in King's L., Hertfordshire, England</td>
</tr>
<tr>
<td><strong>Mother</strong></td>
<td>Roche</td>
</tr>
<tr>
<td><strong>Spouse(s)</strong></td>
<td>Living Windsor</td>
</tr>
<tr>
<td><strong>Children</strong></td>
<td>Living Windsor, Living Windsor</td>
</tr>
</tbody>
</table>

| **Name** | Diana F. Spencer |
| **Birth** | 1961 in King's L., Hertfordshire, England |
| **Mother** | Roche |
2. Click the **Merge** button. The Web Merge Wizard will launch (figure 2-33).

![Web Merge Wizard](image)

*Figure 2-33: Web Merge Wizard*

3. Use the **Back** and **Next** buttons at the bottom of the Web Merge Wizard to go through the steps of the wizard.

Note: On the Individual window of the Web Merge Wizard, the three columns explain how the individual’s information will be merged. The first column shows the information you already have in your tree. Click options in the
first and second columns to indicate if you want the results from the online resource to be preferred information, alternate information, source information, or if you don’t want to merge specific items into your tree. The last column shows what you have chosen to do based on the first and second columns (see figure 2-33 on the previous page).

4. Verify your decision on the Summary Page. Then click **Merge Now**. The information is merged into your tree.

**Part 6: Printing a Family Tree Chart**

You’ve entered information about several of Diana Spencer’s family members, so now you can display and print her family tree. If this were your own family tree, you’d probably want to add more information first. When you are ready to print family trees, reports, or other documents, Family Tree Maker will create them for you automatically.

In this section, you’ll first look at a descendant tree to give you more practice displaying different charts. Then you’ll look at an ancestor tree and print it.

Right now your tree should show Diana Spencer as the primary individual. We want to view a descendant tree for Edward Spencer. Make sure that Edward’s name is
highlighted in the pedigree tree by clicking on his name. By highlighting him, you are making him the “primary individual.” The primary individual is the person being focused on in the tree. For example, in a descendant tree, the primary individual is at the very top of the tree, and the tree shows the primary individual’s descendants.

Trees Charts and Reports in Family Tree Maker

Here’s a list of some of the trees and charts you can create:

**Ancestor trees** (sometimes called “pedigree charts”) show an individual’s ancestors—parents, four grandparents, eight great-grandparents, and more. Family Tree Maker also lets you download blank pedigree charts—a helpful feature that will make your library research much simpler. You can photocopy the form and mail it to your relatives so you can confirm birth dates, wedding dates, and other vital statistics from distant branches of your family.

**Descendant trees** are ideal for family gatherings and reunions because they show where everyone fits in the family. Starting with a relative in the distant past, a descendant tree shows children, grandchildren, great-grandchildren, and so on.

**Reports** are mainstays of family historians. You can create detailed reports about a single nuclear family, such as the Family Group Sheet; relationship reports that show marriage events or parentage facts; and more. Simply select the type of report and format you want, then print—Family Tree Maker does the work for you.

All of these charts and reports are available from the Publish workspace.
Displaying Edward Spencer’s Descendant Tree

1. Click the **Publish** button on the main toolbar.
2. Click the **Collection** tab.
3. In **Publication Types**, click **Charts**. The display area shows the different types of available charts (see figure 2-34.)

![Figure 2-34. The Publish workspace](image)

4. Double-click the **Descendant Chart**.

Family Tree Maker displays a standard vertical descendant tree on your screen. At the top of the tree there are boxes containing information about Edward Spen-
cer and his wives. Beneath them are boxes containing information about his child, Diana, and his grandchildren (figure 2-35).

![Descendant Chart for Edward John Spencer]

*Figure 2-35. Edward Spencer’s descendant tree*

5. At the top of the chart, you can use the **Zoom** dropdown list to change how much of the chart is being displayed. (Using the Zoom feature does not change the size of your tree when you print it.)

You can use the scroll bars that are along the bottom and right sides of your tree to move around and look at different parts of the tree. When you’re through looking at the tree, move on to the next step.
Now, we’ll try a quick way to see another person’s tree.

6. Choose a different primary individual for the tree by clicking “Albert Edward Spencer” in the mini-navigation pedigree tree above the chart (figure 2-36).

Family Tree Maker displays a descendant tree showing the descendants of Albert Spencer and Cynthia Hamilton. If you wanted to print the tree, you would do it from here by clicking the print icon at the top of the window.

Displaying Diana Spencer’s Ancestor Tree

To display an ancestor tree for Diana Spencer, you need to make her the primary individual again and then switch to the ancestor tree chart. You could display Diana by finding her in the mini-navigation pedigree tree (see figure 2-36) as we did in the previous task, but this is a good opportunity to try out a Quick Search.

Finding an Individual with the Quick Search

1. Click the Index of Individuals button next to the mini-navigation pedigree tree (it looks like a file folder).
Family Tree Maker displays the Index of Individuals window (see figure 2-37). Notice that there is a flashing cursor in the Find field at the top of the window. Use this field to do a search.

![Index of Individuals window](image)

**Figure 2-37. Index of Individuals window**

2. Begin typing “Spencer, Diana”.

Notice that you type her last name first. With each character you type, Family Tree Maker moves the highlight closer to her name.

3. Make sure Diana’s name is highlighted and click **OK**.

Family Tree Maker displays a descendant tree with Diana Spencer as the primary individual. Why does it
display a descendant tree? Because the descendant tree is the chart that you were accessing before you clicked the Index of Individuals button. The name you highlight in the Index of Individuals window is the name you see when you return to the previous chart.

4. To change to Diana’s ancestor tree, click the **Collection** tab.

5. In **Publication Types**, click **Charts**. The display area shows the different types of charts.

6. Double-click the **Pedigree Chart**.

   Family Tree Maker displays a standard ancestor tree listing Diana Spencer, her parents, and her grandparents (see figure 2-38 on the next page). Her children are not in this tree because they are her descendants, not her ancestors.

   You can change the appearance of the tree (for example, you can customize with colors and fonts) and the facts it contains (for example, you can add more facts or change the order they’re listed in). For now, you’ll just learn how to control what information prints in the boxes, but be sure to take the time to experiment with the options in the editing panel. It’s a great way to learn how to create beautiful trees and reports.
Selecting Facts to Include in a Chart

1. On the editing panel toolbar, click the **Items to include** button (figure 2-39).

Family Tree Maker displays the Items to Include window, which shows which facts are currently selected to display in the tree.
The default facts in the pedigree chart are Name, Birth, Marriage, and Death (see figure 2-40). Just for practice, you’ll remove some items from the current display.

2. Click **Death** in the Included facts list.

3. Click the red (X) button. This removes that item from all the boxes in the ancestor tree. Now, you will select a new item to include: each individual’s namesake.

4. Click the blue (+) button. The Select Fact window opens.

5. Highlight “Namesake” in the list; then click **OK**.

Family Tree Maker moves “Namesake” to the Included facts list.

*Figure 2-40. Items to Include window*
Changing a Fact’s Format
Now you’re going to change the format of one of the items that you already included in the tree—each individual’s name.

1. The Items to Include window should still be open. Click Name in the Included facts list.

2. Click Name Options. Family Tree Maker displays the Options: Name window (see figure 2-41).

3. Select “First Last” from the Format drop-down list.

   To get an idea of how the name will appear printed, look at the Sample section at the bottom of the window. For example, the name format is now “First Last.” The example shows you the individual’s name—without the middle name.
4. Click **OK**. Family Tree Maker redisplay the Items to Include window.

5. You can include many more items in a tree, but for now, click **OK**.

   Family Tree Maker returns you to the ancestor tree chart with the items you just changed shown in your tree.

**Printing a Tree Chart**

Now, to print Diana’s tree chart:

1. Make sure your printer is turned on and connected to your computer.

2. Click the **Print** icon above the editing panel (see figure 2-42).

   ![Printer icon](image)

   *Figure 2-42. Printer icon*

   Family Tree Maker displays the Print Preview window. This shows you what your tree will look like when it’s printed.

3. If everything in the chart looks correct, click **Print**.
Part 7: Finishing Up
Now that you’ve finished the tutorial, you’ll learn how to back up your files and close the Family Tree Maker program.

Backing Up Your Family Tree Maker Files
Your tree files are important: not only do they contain your family’s history, they also represent hours of your labor. Family Tree Maker automatically saves your information while you are working. You won’t even notice that it’s happening. Unfortunately, entering something on your home computer does not guarantee its permanence. Viruses can infect your data. Your computer may crash or break down, destroying your data or making it inaccessible. CDs can fail or become corrupted. All computers and backup media (such as flash drives) are vulnerable to the usual disasters that nobody likes to think about: fires, floods, power surges, theft. Family Tree Maker can better preserve your family history if you regularly make backups of your files.

Note: You should back up your files frequently on a high-capacity removable disk, CD-ROM, DVD, or on the Web—perhaps each time you use the program.
1. Open the tree for which you want to create a backup.

2. From the File menu, select **Backup**. The Backup window opens (figure 2-43).

![Backup window](image)

*Figure 2-43. Backup window*

3. Select one of these backup options:
   - **Removable Media** saves your file to a floppy diskette, CD, DVD, or flash drive.
   - **Working directory** saves your file to the directory where your current tree is saved on your hard drive.
   - **Custom directory** lets you choose a new location on your hard drive where you want to save your file.

4. Click **OK**.
Backup Files

If you are using floppy disks, use a new set each time or alternate between two sets. Since floppy disks don’t hold much data, you may need several floppy disks, depending on the size of your file. If you have a large file or set of files, it’s better to back up your files to a larger medium such as a CD-ROM (an optical medium, more stable than floppies) or DVD. Recordable CDs and DVDs are quite inexpensive and can hold much larger files. (If you ever need to, you can restore your backup files from a CD in a matter of seconds.)

When you are finished, store the floppy disks or CDs with your family history data in a separate location from your hard drive to protect the information in case of fire or flood. Remember that making backups takes only a few seconds, but researching and entering data is a lengthy process.

Closing Family Tree Maker

When you finish using Family Tree Maker, you need to close the program. Never shut off your computer before closing Family Tree Maker.

1. From the **File** menu, select **Exit**. Family Tree Maker saves your information and then closes the program.
Thank You

Thank you for purchasing Family Tree Maker, and welcome to the exciting world of family history. We know Family Tree Maker will provide many hours of enjoyment as you record and preserve your own family heritage for generations to come.
Although we hope you never have any problems while using Family Tree Maker, all computers and software have their own incompatibilities. This chapter covers a variety of difficulties you might encounter, such as installation and printing problems. If you do need a little assistance to get back on track, you may be able to locate the appropriate topic in this chapter and then fix the problem.

Before You Begin
If you are having problems using Family Tree Maker, you might want to make sure your computer system meets the minimum requirements and make sure that you know how to do a few basic Windows tasks.

Checking System Requirements
Family Tree Maker requires a PC that meets or exceeds the requirements listed on page 2. Also, keep in mind that the more family information you enter, the greater the
amount of free hard drive space and available RAM you will need. If you plan to include many pictures, audio, or video files in your Family Tree Maker trees, you will need a substantial amount of hard drive space.

Note: If your system does not meet these minimum requirements, we cannot guarantee the program will function correctly. You will need to upgrade your system to meet these requirements if you wish to use Family Tree Maker.

Windows Basics
This section describes some of the tasks you might need to do using features that are available in Windows.

Finding a Family Tree Maker File
If you have rearranged your computer files or simply can’t find a Family Tree Maker file, you can use the Windows searching tool to quickly locate it or any Family Tree Maker backups you’ve created.

1. Click the Start button on the Windows taskbar; then select Search. The Search Results window opens.
2. In the search options panel, click the “Documents” link.
3. In the **All or part of the document name** field, enter “.ftm”. Make sure you include the period before “ftm”. That way your results will include files with the .ftm extension—not every file that has the letters FTM in it. If you want to search for your Family Tree Maker backup files, enter “.ftmb”.

The Search Results window shows all the files that match your entry.

You can double-click the icon to open the file, or you can hover your mouse over the file name to see the file’s location, size, and the date it was modified last. Make sure to take note of the file’s location so you can find it in the future.

**Displaying File Extensions**

The default in Windows is to display file names without their extensions. Sometimes it is useful to be able see the file extension to further identify the file. For example, in Family Tree Maker your tree may have the same name as your backup file—the only difference is the file extension. See the sidebar for a description of the file extensions Family Tree Maker uses.

1. Click the **Start** menu; then choose **My Computer**.
Family Tree Maker File Extensions

**.FTM**—This is the “regular” Family Tree Maker extension. All Family Tree Maker trees you create will have this extension.

**.FTMB**—The file extension used for a compressed backup file using the Family Tree Maker Backup command.

**.GED**—The file extension for a GEDCOM file.

**.FTMT**—The file extension used for chart templates.

2. Click the icon for your hard disk (usually Local Disk C:).

3. From the **Tools** menu, select **Folder Options**.

4. Click the **View** tab.

5. Make sure the **Hide extensions for known file types** checkbox is blank.

6. Click **OK** to save your changes and close the dialog box.

Now when you open any folder on your hard drive you will see each file’s extension.

**Installation Problems**

Read through the items below to find your installation problem. The possible solutions are listed below each problem.
The system locks up during installation (you may get the message: “This program has performed an illegal operation and will be shut down”).

Close any programs you’re using including shortcut toolbars that remain on your desktop and any antivirus programs.

In addition, you can get help on the Family Tree Maker website at <www.familytreemaker.com/support>. Click the “Knowledge Base” link. In the Keyword Search field, enter “install” and click the Search button.

Nothing happens when the installation CD is placed in the CD drive.

The Windows Autorun feature may be turned off. You’ll need to start the installation program yourself:

1. Make sure the CD is in the CD drive.

2. Click the Windows Start button; then select Run.

3. In the Open field, type “d:setup”.

Note: The “d” in “d:setup” stands for drive D. If you are installing from a drive other than drive D, type that letter instead. For example, from drive E, type “e:setup”.

4. Click OK.
A message appears saying, “Cannot find d:setup.”

Make sure you type the correct letter for your CD-ROM drive. Often, “d:” represents the CD-ROM drive, in which case you would type “d:setup”.

You may have entered something other than “d: setup” in the “Open” field of the Windows Run dialog box. Check what was entered.

The CD-ROM may be damaged. Contact technical support for assistance.

A message appears saying there isn’t enough hard drive space to install the program.

You may be out of space on the drive where Windows is installed, the drive where you’re attempting to save, or the drive where your temporary folder is located. To ensure that you have sufficient hard drive space, check the following:

- **Hard drive space available on the drive where Windows is installed.** You need to have at least
460MB of space available on the drive where Windows is installed. In addition, Windows needs at least 150MB of free hard drive space to run properly after Family Tree Maker has been installed. You may encounter problems if you have less.

- **Hard drive space available on the drive where Family Tree Maker is saving your projects.** You generally need to have three times the size of your file available because of the way many Windows programs (including Family Tree Maker) save files. For example, if your file is 400,000 bytes, you actually need 1,200,000 bytes (1.2MB) available to save it.

- **Temporary hard drive space.** Windows maintains a temporary folder, usually C:\Windows\Temp, for temporary storage space. This folder can get very full over the months and should be cleaned out on a regular basis. To do this, first close all programs. Go to the Windows Temp folder and delete everything in it. To access the Temp folder, click the Windows **Start** menu and select **Run**. In the **Open** field, type “temp” and click **OK**. Windows opens the Temp folder. (Make sure the title bar says “Temp” before you delete any files.)
Program Unexpectedly Shuts Down

Family Tree Maker may shut down unexpectedly, and you may get an error message.

A message appears saying, “Family Tree Maker has encountered an error and needs to close.”

Usually this message is caused by an old or corrupt Family Tree Maker configuration file. Instructions on deleting this file can be found on the Family Tree Maker website at <www.familytreemaker.com/support>. Click the “Knowledge Base” link. In the Keyword Search field, enter “3749” and click the Search button.

Printing Problems

Read through the items below to find your printing problem. The possible solutions are listed below each problem. In addition, you can get help on the Family Tree Maker website at <www.familytreemaker.com/support>. Click the “Knowledge Base” link. In the Keyword Search field, enter “print” and click the Search button.

Family Tree Maker is printing slowly.

Printing from Windows, especially when printing graphics, can be slow. If you want to print faster, you
can try printing at lower quality, but the output won’t look as nice.

The Windows spool settings may be slowing the printing down. To disable these features, see your Microsoft Windows user’s guide. You may also need to consult the documentation that came with your printer.

Your computer may be running low on memory or resources. You must have at least 50 percent free resources while printing.

Tree charts won’t print on both sides of the paper.

Family Tree Maker does not have the capability to print two-sided documents. To make a two-sided document, you will need to use your printer’s duplex mode.

If you are creating multiple sets of a report or chart, you can print a single, one-sided master set, take it to a copy shop, and have them copy and collate as many two-sided sets as you need. Many copy shops can even bind the documents.
Tree chart boxes are printing without text or the text is printing without boxes.

Family Tree Maker lets you choose your box styles. You may have chosen a box style without a border, or the outline color for the box may be the same color as the background color. To check your box styles, click the **Box and line styles** button on the formatting toolbar.

_________

Click the **Items to include** button on the formatting toolbar to make sure that you have chosen to include facts in your boxes.

Pictures are not printing clearly.

Try selecting a different image format when you import the graphic file. Family Tree Maker accepts a variety of common file formats.

_________

The image may have been poor quality to begin with. If possible, get a better quality image.
Nothing prints at all.

Your printer may be hooked up incorrectly. Check to see if it’s turned on, online, and connected to the computer.

You may have incorrect printer settings or the wrong print driver.

Your computer may be running low on memory or resources. Family Tree Maker requires that you have at least 256MB (megabytes) of physical memory to run. To check the available physical memory on your computer, go to the Help menu and select About Family Tree Maker. Then click System Information. Family Tree Maker displays the System Information dialog box, which displays your physical memory.

If your computer has only 256MB of memory, Family Tree Maker might run slow at times and might take a long time to perform certain tasks like printing, especially if you have a large project. Try closing other programs to make more memory available. If the performance is still sluggish, you might want to consider adding more memory to your system.
PDF Problems

You may encounter problems with using the PDF functions in Family Tree Maker (when you’re saving reports and trees as PDFs). You will need to have administrator rights on your computer. Check the Microsoft XP Help system or go to the Microsoft XP website at <www.microsoft.com/windowsxp> to get assistance with changing settings.

In addition, you can get help on the Family Tree Maker website at <www.familytreemaker.com/support>. Click the “Knowledge Base” link. In the **Keyword Search** field, enter “pdf” and click the **Search** button.

CD-ROM Problems

You may be using an old CD-ROM driver. Call your CD-ROM manufacturer and make sure that you have the latest version of the driver.

If you’re having trouble accessing the installation CD, there may be fingerprints or dust on your CD. Remove the CD from your CD-ROM drive and gently wipe the shiny side with a clean towel. Do not wipe in a circular motion around the CD; instead, wipe from the inside edge to the outside edge.
Index

A
aerial maps, 58–59
ancestor trees
displaying, 69–72
overview, 66
Ancestry.com
activating subscriptions, 11
searching, 60–63
audio files. See media items

B
backing up files, 76–78
birth dates, entering, 19
birthplaces, entering, 19–20

C
categories, media, 52
CD-ROMs, troubleshooting
installation, 85, 92

charts
ancestor, 69–72
customizing, 72–75
descendant, 67–69
overview, 65–66
printing, 75
children, adding to tree, 21–25
closing Family Tree Maker, 78

dates
of events, entering, 19–23
standards for entering, 19–20
deleting individuals from tree,
34–35
descendant trees
displaying, 67–68
overview, 66
E
error messages, 85–88
events, entering, 37–38
extensions, file, 83–84

F
facts
  adding sources for, 39–40
  entering, 37–38
families, entering information about, 16–35
family group view, 22
Family tab, 16–17
Fastfields, 23
fathers, adding to tree, 26–27
file extensions, 83–84
files
  backing up, 76–78
  finding, 82–83
formats of charts, changing, 72–75

G
Getting Started Guide (PDF),
  accessing, 10–11
grandparents, adding to tree, 31–34

H
Help
  Getting Started Guide (PDF), 10–11
  navigating in, 9–10
  Online Help Center, 12
technical support, 12
tutorials, 10
using, 6–10
home person, 34
hybrid maps, 58–59

I
images. See media items.
icorrect information, fixing, 25
installing
  automatically, 3–6
  license agreement, 4
  manually, 5–6
  registering software, 5
troubleshooting, 84–87

L
labeled maps, 59
license agreement, 4
locations, completing with
  Fastfields, 23
M
maps, 56–59
marriages
   entering, 21
   multiple, 28–29
media categories, 52
media items
   adding to tree, 49–52
   categories of, 52
   entering details, 53–54
   linking to individuals, 55–56
   printing, troubleshooting, 90
Media tab, 42
Media workspace, 49
Microsoft Virtual Earth, 59
mini-navigation pedigree
tree, 69
mistakes (text), correcting, 25
mothers, adding to tree, 27

N
names
   completing with Fastfields, 23
   entering, 20
notes, adding to tree, 43–45
Notes tab, 42–43

P
parents, adding to tree, 26–28
PDFs
   of Getting Started Guide, 11–12
   troubleshooting, 92
pedigree trees (chart),
   example, 72
pedigree trees (navigation), 69
People workspace, 16–18
Person tab, 36
photographs. See media items.
“preferred” spouses, 30
printing
   tree charts, 75
   troubleshooting, 88–91

Q
Quick Search, 69–70

R
registering software, 5
relationships, viewing, 49
removing individuals from tree,
   34–35
reports, 66
requirements, system, 1–2,
   81–82
research task, creating, 45–47
road maps, 57

S
searching
for online information, 60–63
for specific individuals, 32–33
setup
installing software, 3–6
system requirements, 1–2
sources, adding to tree, 39–41
spouses
adding to tree, 21–22
multiple, 28–30
“preferred,” 30
standard pedigree trees,
example, 72
subscription (Ancestry.com),
activating, 11
system requirements, 1–2,
81–82

T
tabs
Family, 16–17
Media, 42
Notes, 42–43
Person, 36
Tasks, 42, 45–46
Tasks tab, 42, 45–46
technical support, 12
templates, for sources, 41
timelines, 47–48
to-do tasks, creating, 45–47
tree charts. See charts.
trees
adding
children, 21–25
fathers, 26–27
grandparents, 31–34
media items, 49–52
mothers, 27
notes, 43–45
parents, 26–28
spouses, 21–22, 28–29
backing up, 76–78
charts of, 65–75
creating, 14–16
home person of, 34
maps in, 56–59
merging online information
into, 63–65
removing individual from,
34–35
timelines, 47–48
troubleshooting
CD-ROMs, 92
installation, 84–87
PDFs, 92
printing, 88–91
troubleshooting (continued)
  program shuts down, 88
  system requirements, 81–82
  using Help, 6–10
  tutorials, 10

V
  videos. See media items.

W
  Web Search, 60–62
  Web Search workspace, 61
  Windows, basic tasks, 82–84
  workspaces
    Media, 49, 52
    People, 16–17
    Plan, 14–15
Forget about a green thumb. What you really need to grow a strong family tree is *The Official Guide to Family Tree Maker 2010*. Written by a Family Tree Maker expert who knows the ins and outs of the software, this essential guide gives you the know-how to turn a small family twig into a mighty oak.